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READ AND COMPLY WITH THESE INSTRUCTIONS 
BEFORE INSTALLING, OPERATING, OR SERVICING
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Notice: The manufacturer reserves the right to make any changes and 
improvements to the products described in this manual at any time and without 
notice. This manual is copyrighted. This document may not, in whole or in part, 
be copied, reproduced, translated, or converted to any electronic medium or 
machine readable form, for commercial purposes, without prior written consent 
from the copyright holder.

Note: Although we provide assistance on our products both personally and 
through our literature, it is the complete responsibility of the user to determine 
the suitability of any product to their application.

The manufacturer does not warrant or assume responsibility for the use of its 
products in life support applications or systems.

Warranty
This product is warranted to the original purchaser for a period of one year 
from the date of purchase to be free of defects in material or workmanship. 
Under this warranty the product will be repaired or replaced at manufacturer’s 
option, without charge for parts or labor when the product is carried or shipped 
prepaid to the factory together with proof of purchase. This warranty does not 
apply to cosmetic items, nor to products that are damaged, defaced or otherwise 
misused or subjected to abnormal use. See “Application” under the Installation 
section. Where consistent with state law, the manufacturer shall not be liable for 
consequential economic, property, or personal injury damages. The manufacturer 
does not warrant or assume responsibility for the use of its products in life support 
applications or systems.

Conformity / Supplemental Information:
The product complies with the requirements of the Low Voltage Directive 2006/95/
EC and the EMC Directive 2004/108/EC and carries the CE Marking accordingly. 
Contact the manufacturer for more information.
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Thank you for purchasing a MATHESON Gas Flow Controller. 

Please take the time to read the information contained in this manual. This will 
help to ensure that you get the best possible service from your instrument. 
This manual covers the following MATHESON instruments:

829-Series Mass Gas Flow Controllers

Unless otherwise noted, the instructions in this manual are applicable to all of 
the above instruments.

Full specifications for each device can be found on pages 45 and 46.

Please contact MATHESON at 1-800-828-4313 if you have any 
questions regarding the use or operation of this device.
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GETTING STARTED

829 Mass Flow Controller shown with an upstream valve configuration and 
connection port fittings

MOUNTING
829-Series Gas Flow Controllers have holes on the bottom for mounting to flat
panels. See pages 45-46.
Small valve controllers can usually be mounted in any position.
No straight runs of pipe are required upstream or downstream of the controller.
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PLUMBING
Your controller is shipped with plastic plugs fitted in the port openings. 
To lessen the chance of contaminating the flow stream do not remove 
these plugs until you are ready to install the device.

Make sure that the gas will flow in the direction indicated by the flow arrow.
Standard 829-Series Gas Flow Controllers have female inlet and outlet port 
connections. Other fittings such as NPT, VCR, and other specialty fittings are 
available.
The inlet and outlet port sizes (process connections) for different flow ranges 
are shown on page 45.

Do not use thread sealing Teflon® tape on compression fittings.

On NPT threaded connections, do not wrap the first two threads. This will 
minimize the possibility of getting tape into the flow stream and flow body. 

Do not use pipe dopes or sealants on the process connections as these 
compounds can cause permanent damage to the controller should they get 
into the flow stream.

When changing fittings, carefully clean any tape or debris from the port threads.

We recommend the use of in-line sintered filters to prevent large particulates 
from entering the measurement head of the instrument. Suggested maximum 
particulate sizes are as follows:

15 microns for units with FS flow ranges between 0-100 sccm and 0-1 slpm.
50 microns for units with FS flow ranges of 0-1 slpm or more.

PRESSURE
Maximum operating line pressure is 145psig (1 MPa). 
If the line pressure is higher than 145 psig (1 MPa), use a pressure regulator upstream 
from the flow controller to reduce the pressure to 145 psig (1 MPa) or less. 

CAUTION!  Exceeding the maximum specified line pressure may 
cause permanent damage to the solid-state differential pressure 
transducer.
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POWER AND SIGNAL CONNECTIONS
Power can be supplied to your controller through either the power jack or the RJ45 
connector. 

An AC to DC adapter which converts line AC power to DC voltage and current as 
specified below is required to use the power jack. 

829 controllers require a 12-30Vdc power supply with a 2.1 mm female positive 
center plug capable of supplying 250 mA. 

NOTE: 4-20mA analog output requires at least 15 Vdc.

1. RS-232 Receive
2. Ground
3. Analog Output
4. RS-232 Transmit
5. Power Supply
6. Power Supply
7. Analog Input
8. Ground

1 2 3 4 5 6 7 8

RJ45 Device

8 7 6 5 4 3 2 1

RJ45 Cable

INPUT SIGNALS
Analog Input Signal

Apply analog input to Pin 7.

Standard 0-5 Vdc is the standard analog input signal. Apply the 0-5 Vdc input 
signal to pin 7, with common ground on pin 8. 

Optional 4-20 mA: If specified at time of order, a 4-20 mA input signal can be 
applied to pin 7, with common ground on pin 8. 

NOTE: This is a current sinking device. The receiving circuit is essentially 
a 250 ohm resistor to ground. 

CAUTION!  Do not connect this device to “loop powered’” systems, 
as this will destroy portions of the circuitry and void the warranty. If 
you must interface with existing loop powered systems, always use a 
signal isolator and a separate power supply.
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RS-232 Digital Input Signal

To use the RS-232 input signal, connect the RS-232 Output Signal (Pin 5), the 
RS-232 Input Signal (Pin 3), and Ground (Pin 8) to your computer serial port as 
shown below. (See page 26 for details on accessing RS-232)













9 8 7 6



9876

15 3 24 1 532 4

Serial Cable End PC Serial Port

OUTPUT SIGNALS

RS-232 Digital Output Signal

To use the RS-232 output signal, it is necessary to connect the RS-232 Output Signal 
(Pin 4), the RS-232 Input Signal (Pin 1), and Ground (Pin 8) to your computer serial 
port as shown. (See page 26 for details on accessing RS-232 output.)

Standard Voltage (0-5 Vdc) Output Signal

829-Series flow controllers equipped with a 0-5 Vdc (optional 0-10 Vdc) will
have this output signal available on Pin 3. This output is generally available in
addition to other optionally ordered outputs. This voltage is usually in the range
of 0.010 Vdc for zero flow and 5.0 Vdc for full-scale flow. The output voltage is
linear over the entire range. Ground for this signal is common on Pin 8.

Optional Current (4-20 mA) Output Signal

If your controller was ordered with a 4-20 mA current output signal, it will 
be available on Pin 3. (See the Calibration Data Sheet that shipped with your 
controller to determine which output signals were ordered.) The current signal 
is 4 mA at 0 flow and 20 mA at the controller’s full scale flow. The output 
current is linear over the entire range. Ground for this signal is common on Pin 
8. (Current output units require 15-30Vdc power.)
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#C
+21.50

 +0.00
CCM

MENU/
TOTAL 

SETPT
0.000  

SCCM
Air

PSIA
+13.60

 +0.00
 SCCM

Main

+0.00

The Main display shows pressure, 
temperature, set‑point, volumetric flow 
and mass flow.
Pressing the button adjacent to a 
parameter will make that parameter 
the primary display unit.
By hitting the MENU button at the 
bottom right of the screen you will 
enter the Select Menu display. 

DISPLAYS AND MENUS
The device screen defaults to Main display as soon as power is applied to the controller.
Note: See page 24 to rotate the display 180°.

Select Menu
From Select Menu you can change 
the selected gas, interact with your 
RS-232 settings, read manufacturer’s 
data or access the control set-up 
display. 
Push MAIN to return to the Main display.

CONTROL
SETUP

RS232 
COMM

MFG
DATA

MAIN

MISC

GAS
SELECT

Select Menu
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MAIN 
This mode defaults on power up, with 
mass flow as the primary displayed 
parameter. 
The following parameters are displayed in 
the Main mode.
Gas Absolute Pressure: This sensor 
references hard vacuum and reads 
incoming pressure both above and below 
local atmospheric pressure. This parameter 
is moved to the primary display by pushing 
the button above PSIA. 
The engineering unit associated with 
absolute pressure is pounds per square 
inch absolute (psia). This can be converted 

to gage pressure (psig) by subtracting local atmospheric pressure from the 
absolute pressure reading:

PSIG = PSIA – (Local Atmospheric Pressure)
Gas Temperature: 829-Series flow 
controllers measure the incoming 
temperature of the gas flow. The 
temperature is displayed in degrees Celsius 
(°C). This parameter is moved to the primary 
display by pushing the button above °C.
Pushing the button again allows you to 
select 0C (Celsius), K (Kelvin), 0F (Fahrenheit) 
or 0R (Rankine) for the temperature scale. 
To select a temperature scale, use the UP 
and DOWN buttons to position the arrow in 
front of the desired scale. 
Press SET to record your selection and 
return to the MAIN display. The selected 

temperature scale will be displayed on the screen.
Set Point: The set-point (SETPT)is shown in the upper right of the display. 

For information on changing the set-point see SETPT SOURCE, page 14.
Volumetric Flow Rate: This parameter is located in the lower left of the display. 
It is moved to the primary display by pushing the button below CCM in this 
example. Your display may show a different unit of measure.

#C
+21.50

+0.00
CCM

MENU/
TOTAL

SETPT
+0.00 

SCCM
Air

PSIA
+13.60

+0.00
SCCM

DOWN

CANCEL SET

  >#C
  K
  #F
  #R

UP

+0.00
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Mass Flow Rate: The mass flow rate is the volumetric flow rate corrected to a 
standard temperature and pressure (typically 14.696 psia and 25 °C). 
This parameter is located in the lower middle of the display. It can be moved to 
the primary display by pushing the button below SCCM in this example. Your 
display may show a different unit of measure preceded by the letter S.

To get an accurate volumetric or mass flow rate, the gas being measured 
must be selected. See Gas Select, page 18. 

MENU: Pressing MENU switches the screen to the Select Menu display.

Flashing Error Message: An error message (MOV = mass overrange, VOV 
= volumetric overrange, POV = pressure overrange, TOV = temperature 
overrange) flashes when a measured parameter exceeds the range of the 
sensor. When any item flashes, neither the flashing parameter nor the 

mass flow measurement is accurate. Reducing the value of the flashing parameter 
to within specified limits will return the unit to normal operation and accuracy. 

If the unit does not return to normal operation contact MATHESON.

When using a mass flow controller as an absolute pressure controller, 
the mass flow rate may momentarily exceed the flow measurement 
capability (full scale + 28%) of the unit. this may occur when the unit is 
asked to make an abrupt pressure change. 
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SELECT MENU
From Select Menu you can change the selected gas, interact with your 
RS‑232 settings, read manufacturer’s data and access the control setup and 
miscellaneous screens.
Press the button next to the desired operation to bring that function to the screen.

Miscellaneous
Communications Select

Control Setup

Main

Manufacturer Data

An explanation for each screen can be found on the following pages.

#C
+21.50

+0.00
CCM MAIN

SETPT
0.000  

SCCM
Air

PSIA
+13.60

+0.00
SCCM

Gas Select

MODEL
INFO

BACK MAIN

LOOP
VAR

- ON -
AUTO
TARE PID MAIN

SETPT
SOURCE

MISC2

BACK
DEVICE 
UNITS MAIN

MISC1

DOWN

CANCEL SELECT

PAGE

>Recent
 Standard
 Factory Custom
 COMPOSER User Mixes
 Bioreactor
 Breathing
 Chromatography
 Fuel

UP

BACK MAIN

UNIT ID
A

BAUD
19200

SETPT
+0.00 

CONTROL
SETUP

RS232 
COMM

MFG
DATA

MAIN

MISC

GAS
SELECT

Select Menu

+ 0.00

MATHESON

Ph    800-828-4313
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CONTROL SETUP 
Control Setup is accessed by pressing the button below Control Setup on the 
Select Menu display. From this screen you can select your set-point source, 
choose a loop variable and adjust the PID terms.

Press BACK to return to the Select Menu 
display. 
Press MAIN to return to the MAIN display.
SETPT SOURCE – Pressing the button 
above SETPT SOURCE will allow you to 
select how the set point will be conveyed 
to your controller. 
Use the line-up and line-down buttons 
to move the arrow in front of the desired 
option. Then press SET.
Press CANCEL to return to the previous 
display. 
The controller will ignore any set-point 
except that of the selected set-point 
source and it will remember which input is 
selected even if the power is disconnected.
Serial refers to a remote digital RS-232 
set-point applied via a serial connection 
to a computer or PLC as described in the 
installation and RS‑232 sections of this 
manual. Use this setting with the BCL-9 
and control or mixing software. 
Front Panel refers to a set-point applied 
directly at the controller. 

Front Panel input must be selected 
prior to changing the set-point at 
the device. 

Analog refers to a remote analog set-point applied to Pin 7 of the RJ45 
connector as described in the installation section of this manual.
Use this setting when connecting to Matheson’s 8284A Dynablender Plus, or 
827A single channel controller.
The standard analog input is 0-5 Vdc. If nothing is connected to Pin 7, and the 
controller is set for analog control, the device will generate random set-point values. 
SETPT refers to the set-point. This parameter may be changed using the display 
only if FRONT PANEL is selected as the Input. Press SETPT. Then use SELECT to 
choose the decimal with the arrow and the UP and DOWN buttons to change 
the value. Press SET to record your value. Press CLEAR to return to zero.

DOWN

CANCEL SET

UP

 >Serial / FRONT PANEL
 ANALOG

LOOP
VAR

- ON -
AUTO
TARE PID MAIN

SETPT
SOURCE

SETPT
+0.0
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CAUTION!  Never leave a controller with a non-zero set‑point if no 
pressure is available to make flow. The controller will apply full 
power to the valve in an attempt to reach the set‑point. When there 
is no flow, this can make the valve very HOT!

CONTROL SETUP (continued)
LOOP VAR—The selection of what variable 
to close the loop on is a feature unique to 
MATHESON mass flow controllers. 
Pressing the LOOP VAR button on the 
Control Setup screen will allow you to 
change what variable is controlled. 
Use the line-up and line-down buttons to 
move the arrow in front of the desired 
option. 
When the mass flow controller is supplied 
with the control valve upstream of the 
electronics portion of the system, the unit 
can be set to control on outlet pressure 
(absolute pressures only) or volumetric flow 
rate, instead of mass flow rate. 
The change from mass to volume can usually 
be accomplished without much, if any, 
change in the P and D settings. 

When you change from controlling 
flow to controlling pressure, 
sometimes fairly radical changes 

must be made to the P & D variables. See 
page 16 – PID TUNING.
Contact MATHESON if you are having 
difficulties with this procedure.

ON AUTO / OFF AUTO—refers to the standard auto-tare or “auto-zero” feature.

The auto-tare feature automatically tares (takes the detected signal as zero) the 
unit when it receives a zero set-point for more than two seconds. 
A zero set-point results in the closing of the valve and a known “no flow” 
condition. This feature makes the device more accurate by periodically 
removing any cumulative errors associated with drift. 

It is recommended that the controller be left in the default auto-tare ON 
mode unless your specific application requires that it be turned off. 

DOWN

CANCEL SET

UP

 >Mass Flow
 Volumetric Flow
 Pressure

LOOP
VAR

-ON-
AUTO
TARE PID MAIN

SETPT
SOURCE

SETPT
+0.0
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PID TUNING

PID Values determine the performance 
and operation of your proportional control 
valve. These terms dictate control speed, 
control stability, overshoot and oscillation. 
All units leave the factory with a generic 
tuning designed to handle most applications. 
If you encounter issues with valve stability, 
oscillation or speed, fine tuning these 
parameters may resolve the problem.
MATHESON controllers allow you to 
adjust the Proportional, Integral and 
Differential terms of the PID control loop. 
To change the PID loop parameters, push 
the button below PID.
Press LOOP TYPE. Then use the UP and 
DOWN buttons to select the appropriate 
PID control algorithm. Press SET.
See the following page for descriptions 
of the PID Loop Types (PID Control 
Algorithms).

P refers to the Proportional term of the 
PID loop. 
I refers to the Integral term of the PID loop. 
D refers to the Differential term of the PID 
loop. 
Press P, I or D. Then use SELECT to choose 
the digit with the arrow and the UP and 
DOWN buttons to change the value. Press 
SET to record your value. Press CLEAR to 
return to zero.

Before changing the P, I or D 
parameter, please record the initial 
value so that it can be returned to 

the factory setting if necessary.
Valve tuning can be complex. If you 
would like assistance, please 
contact MATHESON for technical 
support.

I
00000

BACK
LOOP
TYPE MAIN

P
00100

D
02501

DOWN

CANCEL SET

UP

 > PD PID
 PD2I PID

LOOP
VAR

-ON-
AUTO
TARE PID MAIN

SETPT
SOURCE

SETPT
+0.0
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The PD algorithm is the PID algorithm used on most MATHESON controllers.
It is divided into two segments:
The first compares the process value to the set-point to generate a proportional 
error. The proportional error is multiplied by the ‘P’ gain, with the result added 
to the output drive register. 
The second operates on the present process value minus the process value during 
the immediately previous evaluation cycle. This ‘velocity’ term in multiplied by 
the ‘D’ gain, with the result subtracted from the output drive register. 
The above additions to and subtractions from the output drive register 
are carried over from process cycle to process cycle, thus performing the 
integration function automatically. 
Increasing the ‘P’ gain will promote the tendency of the system to overshoot, 
ring, or oscillate. 
Increasing the ‘D’ gain will reduce the tendency of the system to overshoot. 
The PD2I algorithm is a PID algorithm used primarily for high performance 
pressure and flow control applications. 
It exhibits two basic differences from the PD algorithm that most controllers utilize.

1. Instead of applying a damping function based upon the rate of change of the 
process value, it applies a damping function based upon the square of the rate of 
change of the process value.
2. The damping function is applied directly to the proportional error term
before that term is used in the proportional and integral functions of the
algorithm. This provides a certain amount of ‘look ahead’ capability in the
control loop.

Because of these differences, you will note the following:
1. Increasing ‘P’ gain can be used to damp out overshoot and slow oscillations
in pressure controllers. You will know that ‘P’ gain is too high, when the
controller breaks into fast oscillations on step changes in set-point. On flow
controllers, too high a ‘P’ gain results in slower response times. Too low a ‘P’
gain results in overshoot and/or slow oscillation. A good starting value for ‘P’
gain is 200.
2. If the unit was originally shipped with the PD2I algorithm selected, the
‘D’ gain value should be left at or near the factory setting because it relates
primarily to the system phase lags. If you are changing from the default
algorithm to the PD2I algorithm, you should start with a ‘D’ gain value of 20.
3. The ‘I’ gain is used to control the rate at which the process converges
to the set-point, after the initial step change. Too low a value for ‘I’ gain
shows up as a process value that jumps to near the set-point and then takes
awhile to converge the rest of the way. Too high a value for ‘I’ gain results in
oscillation. A good starting value for the ‘I’ gain is 200.
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GAS SELECT™
Gas Select allows you to set your 
device to up to 150 standard gases and 
mixes. You can also use COMPOSER to 
program and store up to 20 additional 
gas mixes.

Gas Select is accessed by pressing the 
button below GAS SELECT on the Select 
Menu display. 

To select a gas, use the UP and DOWN 
buttons to position the arrow in front of 
the desired gas category. 
» Recent: Eight most recent selections
» Standard: Gases and mixes (page 39)
»» Factory Custom: Present only if customer 

requested gases were added at the factory
» COMPOSER User Mixes: Gas mixes
programmed by the user (page 19)
» Bioreactor (page 36)
» Breathing (page 37)
» Chromatography (page 39)
» Fuel (page 38)
» Laser (page 38)
» O2 Concentrator (page 39)
» Pure Non-Corrosive (page 34)
» Stack (page 39)
» Welding (page 35)

Press PAGE to view a new page in the
gas category list.

Press SELECT to view the gases in the 
selected category. Align the arrow with the desired gas. Press SET to record your 
selection and return to the MAIN display. The selected gas will be displayed on 
the screen.

Note: Gas Select may not be available on units ordered with a custom gas or blend.

See pages 34-39 for a full list of gases in each category. 

DOWN

CANCEL SET

PAGE

>Recent
 Standard
 Factory Custom
 COMPOSER User Mixes
 Bioreactor
 Breathing
 Chromatography
 Fuel 

UP

DOWN

CANCEL SET

PAGE

> Fuel
 Laser
 O2 Concentrator
 Pure Non-Corrosive
 Stack
 Welding

UP
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COMPOSER™
COMPOSER allows you to program 
and save up to 20 custom gas mixes 
containing 2 to 5 component gases 
found in the gas lists (pages 34-39). The 
minimum resolution is 0.01%.

COMPOSER is accessed by selecting 
COMPOSER User Mixes on the GAS 
SELECT display.

Press SET when the arrow is aligned 
with Add Mix.

Name the mix by pressing the UP and 
DOWN buttons for letters, numerals and 
symbols. 

CHANGE CASE – Toggles the letter case. 
Letters remain in selected case until 
CHANGE CASE is pushed again.

Press SET to save the name.

After naming the mix, press ADD GAS 
and select the gas category and the 
component gas.

Select the digit with arrow and adjust 
the % with the UP and DOWN buttons. 
Press set to save. Add up to 4 more 
gases as needed. The total must equal 
100% or an error message will appear.

GAS OPTNS allows you to adjust the 
percentage of the constituents or delete 
a gas from the mix. Gas mixes cannot be 
adjusted after they have been saved.

DOWN

CANCEL SET

>Add Mix: 20 Free
UP

DOWN

BACK/
CANCEL

CHANGE 
CASE SET

NEXT
LETTER

COMPOSER Mix name:

MyGas
------˄

UP

ADD GAS

BACK/
CANCEL

CHANGE 
CASE SET

GAS 
OPTNS

COMPOSER Mix: MyGAS

  0.00% of Total

EDIT 
NAME
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Once the mix has been saved, you 
may press CREATE SIMILAR to 
compose an additional mix based 
on the mix you have just saved. 
This CREATE SIMILAR option is not 
available after leaving this screen.

Press CREATE NEW to add a 
completely new mix.

Press SELECT MIXTURE to bring the 
custom mix onto the MAIN display.

MAIN
SELECT 
MIXTURE

CREATE 
SIMILAR

COMPOSER USER MIX
MyGas

HAS BEEN SAVED

CREATE 
NEW

DOWN

BACK/
CANCEL CLEAR SET

SELECT 
DIGIT

Percent of Air:

	 50.00
˄

UP DOWN

BACK/
CANCEL CLEAR SET

SELECT 
DIGIT

Percent of Ar Argon:

	 30.00
˄

UP

DOWN

BACK/
CANCEL CLEAR SET

SELECT 
DIGIT

Percent of He Helium:

	 20.00
˄

UP ADD GAS

CANCEL SAVE

GAS 
OPTNS

COMPOSER Mix: MyGAS
  50% Air
   30% AR Argon
   20% He Helium
 100.00%  Total

EDIT 
NAME
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COMMUNICATION SELECT
Access Communication Select by pressing 
the button above RS232 COMM on the 
Select Menu display. 

Unit ID – Valid unit identifiers are the 
letters A-Z and @. The identifier allows 
you to assign a unique address to each 
device so that multiple units can be 
connected to a single RS‑232 computer 
port. 
Press UNIT ID. Use the UP and DOWN 
buttons to change the Unit ID. Press SET to 
record the ID. Press Reset to return to the 
previously recorded Unit ID.
Any Unit ID change will take effect when 
Communication Select is exited.
If the symbol @ is selected as the Unit 
ID, the device will enter streaming mode 
when Communication Select is exited. 
See RS-232 Communications (page 31) for 
information about the streaming mode.

Baud – Both this instrument and your 
computer must send/receive data at the 
same baud rate. The default baud rate for 
this device is 19200 baud. 
Press BAUD. Use the UP and DOWN 
buttons  to select the baud rate that 
matches your computer. The choices are 
38400, 19200, 9600, or 2400 baud. Press 
SET to record the baud rate.
Any baud rate change will not take effect 
until power to the unit is cycled.

UP

BACK RESET A SET

UNIT ID
C

DOWN

DOWN

BACK SET

BAUD UP

19200

BACK MAIN

UNIT ID
A

BAUD
19200

C
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MISCELLANEOUS 
Miscellaneous is accessed by pressing the MISC button on the Select Menu display. 
Next select either MISC1 or MISC2. 

MISC1 will display as shown at left.
ZERO BAND refers to Display Zero Deadband. 
Zero deadband is a value below which the display 
jumps to zero. This deadband is often desired to 
prevent electrical noise from showing up on the 
display as minor flows or pressures that do not 
exist. Display Zero Deadband does not affect the 
analog or digital signal outputs.
ZERO BAND can be adjusted between 0 and 
6.3% of the sensor’s Full Scale (FS). 
Press ZERO BAND. Then use SELECT to choose 
the digit with the arrow and the UP and DOWN 
buttons to change the value. Press SET to record 
your value. Press CLEAR to return to zero.
Pressure Averaging and Flow Averaging may 
be useful to make it easier to read and interpret 
rapidly fluctuating pressures and flows. Pressure 
and flow averaging can be adjusted between 1 
(no averaging) and 256 (maximum averaging). 
These are geometric running averages where 
the number between 1 and 256 can be 
considered roughly equivalent to the response 
time constant in milliseconds. 

This can be effective at “smoothing” high frequency process oscillations such as 
those caused by diaphragm pumps. 
Press PRESS AVG. Then use SELECT to choose the digit with the arrow and the UP and 
DOWN buttons to change the value. Press SET to record your value. Press CLEAR to 
return to zero.

Press FLOW AVG. Then use SELECT to choose the 
digit with the arrow and the UP and DOWN buttons 
to change the value. Press SET to record your value. 
Press CLEAR to return to zero.
Setting a higher number will equal a smoother 
display. 
LCD CONTRAST: The display contrast can be 
adjusted between 0 and 31, with zero being the 
lightest and 31 being the darkest. Use the UP 
and DOWN buttons to adjust the contrast. Press 
SET when you are satisfied. Press CANCEL to 
return to the MISC display.

PRESS
AVG

BACK

LCD

CONTRAST MAIN

ZERO
BAND

FLOW
AVG

DOWN

CANCEL CLEAR SET

UP SELECT

0.0

>

DOWN

CANCEL RESET SET

UP

11
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MISC2 will display as shown at left. 
STP/NPT refers to the functions that allow 
your selection of standard temperature and 
pressure conditions or normal temperature 
and pressure conditions. This feature is 
generally useful for comparison purposes to 
other devices or systems using different STP 
parameters. 
The STP menu is comprised of the STP TEMP 
and STP PRESS screens. 
STP TEMP allows you to select from 0C, 0F, K 
or 0R. The arrow position will automatically 
default to the currently stored value. 
The NTP menu is comprised of the NTP TEMP 
and NTP PRESS screens. 
Once a selection has been made and recorded 
using the SET button, a change acknowledgement 
message will be displayed on screen. 
Selecting MAIN will revert screen to the Main 
display. If the SET selection is already the 
currently stored value, a message indicating 
that fact will appear.
STP PRESS enables you to select from a menu 
pressure settings. Use the UP/DOWN or PAGE 
buttons to view the settings.

The arrow position will automatically default to the currently stored value. 
Once a selection has been made and recorded using the SET button, a change 
acknowledgement message will be displayed on screen. 
Pressing SET again will revert screen to the Main display. If the SET selection is 
already the currently stored value, a message indicating that fact will appear. 

DIAG
TEST

BACK MAIN

STP/
NTP

ROTATE 
DISP

STP
PRESS

MAIN

STP
TEMP

STP TEMP Display

CLEAR

DOWN

BACK/
CANCEL

Temperature: #C

SET

UP SELECT
DIGIT

25.0000

STP PRESS Display

101355.0

DOWN

BACK/
CANCEL SET

UP SELECT
DIGIT

Pressure: PaA

CLEAR
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DIAG TEST: This diagnostic screen displays 
the current internal register values, which 
is useful for noting factory settings prior to 
making any changes. It is also helpful for 
troubleshooting with MATHESON customer 
service personnel.
Select the DIAG TEST button from the MISC2 
screen to view a list of select register values. 
Pressing the SCROLL button will cycle the 
display through the register screens. An 
example screen is shown at left.

Press ROTATE DISP and SET to Inverted 180° if your device is inverted. The 
display and buttons will rotate together.

BACK MAIN

SCROLL
R8:     AP Sig	 7871
R9:     Temp Sig	 39071
R10:    DP Side	 9986
R11:     DP Brdg	 36673
R13:    AP Brdg	 36673
R16:    Meter Func	 199
R18:    Power Up	 32768

DEVICE UNITS
Press DEVICE UNITS to access menus of 
units of measure for each parameter.
Scroll to the desired unit and press select.
Once selected, you will see the message 
shown below. Verify that all connected 
devices expect the change.
See pages 40 and 41 for a full list of 
available units.

DOWN

DONE SELECT

Mass Flow
Volumetric Flow
Pressure
Temperature

UP

DOWN

CANCEL SET

PAGE

SCCM
Scm3/h
Sm3/h
Sm3/d
Sin3/m
SCFH
NmL/s

UP
PRESSING SET WILL

AFFECT DISPLAY
AND SERIAL VALUES

VERIFY CONNECTED 
SERIAL DEVICES 

EXPECT THE CHANGE

SETCANCEL
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MANUFACTURER DATA
Manufacturer Data is accessed by pressing 
the MFG DATA button on the Select Menu 
display. 

The initial display shows the name and 
telephone number of the manufacturer.

Press MODEL INFO to show important 
information about your flow device 
including the model number, serial 
number, and date of manufacture. 

Press BACK to return to the MFG DATA 
display.

Push MAIN to return to the Main display.

MODEL
INFO

BACK MAIN

MATHESON

Ph    800-828-4313

BACK MAIN

MODEL:  829-100SCCM-D
SERIAL NO: � 100903
DATE  MFG:  10/7/2015
DATE  CAL:  10/9/2015
CAL  BY:  DL
SW REV:  5v00.G
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RS-232 Output and Input

Configuring HyperTerminal®:
1. Open your HyperTerminal® RS-232 terminal program (installed under the

“Accessories” menu on all Microsoft Windows® operating systems).
2. Select “Properties” from the file menu.
3. Click on the “Configure” button under the “Connect To” tab. Be sure the

program is set for: 19,200 baud (or matches the baud rate selected in the RS-
232 communications menu on the meter) and an 8-N-1-None (8 Data Bits,
No Parity, 1 Stop Bit, and no Flow Control) protocol.

4. Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI
or Auto Detect.

5. Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line
Feeds” box is not checked and the “Echo Typed Characters Locally” box and
the “Append Line Feeds to Incoming Lines” boxes are checked. Those settings
not mentioned here are normally okay in the default position.

6. Save the settings, close HyperTerminal® and reopen it.
Streaming Mode
In the default Polling Mode, the screen should be blank except the blinking cursor. In 
order to get the data streaming to the screen, hit the “Enter” key several times to clear 
any extraneous information. Type “*@=@” followed by “Enter” (or using the RS‑232 
communication select menu, select @ as identifier and exit the screen). If data still 
does not appear, check all the connections and COM port assignments.
Streaming Mode – Advanced 
The streaming data rate is controlled by register 91. The recommended default rate 
of data provision is once every 50 milliseconds and this is suitable for most purposes. 
If a slower or faster streaming data rate is desired, register 91 can be changed to a 
value from 1 millisecond to 65535 milliseconds, or slightly over once every minute. 
Below approximately 40 milliseconds, data provision will be dependent upon 
how many parameters are selected. Fewer data parameters can be streamed 
more quickly than more. It is left to the user to balance streaming speed with 
number of parameters streamed. 
To read register 91, type “*r91” followed by “Enter”. 
To modify register 91, type “*w91=X”, where X is a positive integer from 1 to 
65535, followed by “Enter”. 
To return to the recommended factory default streaming speed, type “*w91= 50”.
Changing From Streaming to Polling Mode: 
When the meter is in the Streaming Mode, the screen is updated approximately 
10-60 times per second (depending on the amount of data on each line) so that
the user sees the data essentially in real time. It is sometimes desirable, and
necessary when using more than one unit on a single RS-232 line, to be able to
poll the unit.
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In Polling Mode the unit measures the flow normally, but only sends a line of data 
when it is “polled”. Each unit can be given its own unique identifier or address. 
Unless otherwise specified each unit is shipped with a default address of capital A. 
Other valid addresses are B thru Z.
Once you have established communication with the unit and have a stream of 
information filling your screen:
1. Type *@=A followed by “Enter” (or using the RS-232 communication select

menu, select A as identifier and exit the screen) to stop the streaming mode
of information. Note that the flow of information will not stop while you
are typing and you will not be able to read what you have typed. Also, the
unit does not accept a backspace or delete in the line so it must be typed
correctly. If in doubt, simply hit enter and start again. If the unit does not
get exactly what it is expecting, it will ignore it. If the line has been typed
correctly, the data will stop.

2. You may now poll the unit by typing A followed by “Enter”. This does an
instantaneous poll of unit A and returns the values once. You may type A
“Enter” as many times as you like. Alternately you could resume streaming
mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the
unit from the streaming mode.

3. To assign the unit a new address, type *@=New Address, e.g. *@=B. Care
should be taken not to assign an address to a unit if more than one unit is
on the RS-232 line as all of the addresses will be reassigned. Instead, each
should be individually attached to the RS-232 line, given an address, and
taken off. After each unit has been given a unique address, they can all be
put back on the same line and polled individually.

Sending a Set-point via RS-232: To send a set-point via RS-232, “Serial” must be 
selected under the “Input” list in the control set up mode. 
Method 1:  Set-point may be set in floating point in serial communication using 
serial command (UnitID)SX.YZ 

Example:  AS4.54 results in Unit ID A changing set-point to 4.54.  
Method 2: Type in a number between 0 and 65535 (2% over range), where 64000 
denotes full-scale flow rate, and hit “Enter”. 
The set-point column and flow rates should change accordingly. If they do not, 
try hitting “Enter” a couple of times and repeating your command. The formula 
for performing a linear interpolation is as follows:

Value = (Desired Set-point X 64000) / Full Scale Flow Range
For example, if your device is a 100 slpm full-scale unit and you wish to apply a 
set-point of 35 slpm you would enter the following value:

22400 = (35 slpm X 64000) / 100 slpm
If the controller is in polling mode as described in Changing from Streaming 
Mode to Polling Mode, the set-point must be preceded by the address of the 
controller. For example, if your controller has been given an address of D, the 
set-point above would be sent by typing:  D22400 followed by “Enter”
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To adjust the Proportional and Differential (P&D) terms via RS-232:

Type *@=A followed by “Enter” to stop the streaming mode of information.

To adjust the “P” or proportional term of the PID controller, type *R21 followed 
by “Enter”.

The computer will respond by reading the current value for register 21 between 
0-65535. It is good practice to write this value down so you can return to the
factory settings if necessary. Enter the value you wish to try by writing the new
value to register 21. For example, if you wished to try a “P” term of 220, you
would type *W21=220 followed by “Enter” where the bold number denotes the
new value.

The computer will respond to the new value by confirming that 21=220. To 
see the effect of the change you may now poll the unit by typing A followed 
by “Enter”. This does an instantaneous poll and returns the values once.  You 
may type A “Enter” as many times as you like. Alternately you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat step 3 to remove 
the unit from the streaming mode.

To adjust the “D” or proportional term of the PID controller, type *R22 followed 
by “Enter”.

The computer will respond by reading the current value for register 22 between 
0-65535. It is good practice to write this value down so you can return to the
factory settings if necessary. Enter the value you wish to try by writing the new
value to register 22. For example, if you wished to try a “D” term of 25, you
would type *W22=25 followed by “Enter” where the bold number denotes the
new value.

The computer will respond to the new value by confirming that 22=25. To see the 
effect of the change you may now poll the unit by typing A followed by “Enter”. 
This does an instantaneous poll and returns the values once. You may type A 
“Enter” as many times as you like. Alternately you could resume streaming mode 
by typing *@=@ followed by “Enter”. Repeat.

You may test your settings for a step change by changing the set-point. To do 
this type A32000 (A is the default single unit address, if you have multiple 
addressed units on your RS-232 line the letter preceding the value would change 
accordingly.) followed by “Enter” to give the unit a ½ full scale set-point. Monitor 
the unit’s response to the step change to ensure it is satisfactory for your needs. 
Recall that the “P” term controls how quickly the unit goes from one set-point to 
the next, and the “D” term controls how quickly the signal begins to “decelerate” 
as it approaches the new set-point (controls the overshoot).
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Gas Select – The selected gas can be changed via RS-232 input. To change the 
selected gas, enter the following commands:

In Polling Mode:	 Address$$#<Enter>	    (e.g. B$$#<Enter>)

Where # is the number of the gas selected from the table below. Note that 
this also corresponds to the gas select menu on the flow controller screen. The 
Standard gas category is shown in the example below:

# GAS
0 Air Air
1 Argon     Ar
2 Methane    CH4
3 Carbon Monoxide    CO
4 Carbon Dioxide    CO2
5 Ethane    C2H6
6 Hydrogen    H2
7 Helium    He
8 Nitrogen    N2
9 Nitrous Oxide    N2O

10 Neon    Ne
11 Oxygen    O2
12 Propane    C3H8
13 normal-Butane    n-C4H10
14 Acetylene    C2H2
15 Ethylene    C2H4
16 iso-Butane i-C2H10
17 Krypton Kr
18 Xenon Xe
19 Sulfur Hexafluoride SF6
20 75% Argon / 25% CO2 C-25
21 90% Argon / 10% CO2 C-10
22 92% Argon / 8% CO2 C-8
23 98% Argon / 2% CO2 C-2
24 75% CO2 / 25% Argon C-75
25 75% Argon / 25% Helium HE-75
26 75% Helium / 25% Argon HE-25

27 90% Helium / 7.5% Argon / 2.5% CO2
(Praxair - Helistar® A1025) A1025

28 90% Argon / 8% CO2 / 2% Oxygen
(Praxair - Stargon® CS) Star29

29 95% Argon / 5% Methane P-5

For example, to select Propane, enter:  $$12<Enter>
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Creating and Deleting Gas Mixtures with COMPOSER™ using RS-232
Note: All commands must be prefixed with the unit ID letter. The unit should 
not be in streaming mode.
You may create and store up to 20 gas mixtures containing up to five 
constituent gases each. The constituent gases must be chosen from the existing 
list of gases installed on the device (which may vary model to model). Please 
see pages 39 – 46 for lists of gases and their corresponding gas numbers.
Create a Gas Mixture
To create a gas mixture, enter a single-line command according to the following formula: 
[Unit ID] GM [Gas Name] [Gas Mix Number] [Percent 1] [Gas Number 1] 
[Percent 2] [Gas Number 2] …etc. etc.
Notes: Do not type the brackets. There should be only one space between 
all items. Any percentages less than 1, should have a leading zero before 
the decimal (i.e. 0.25 for .25%). Trailing zeros are not necessary but they are 
allowed to help visualize the percentages on screen (as in the example). The 
sum of all percentages must be 100.00 otherwise an error will occur.
Here is an example of a three gas mixture for a new gas called “MyMix1” 
(50% O2, 49.5% Helium, and .5% Neon), stored in user location #236, where the 
unit ID of the device is “A”:

A GM MyMix1 236 50.00 11 49.50 7 0.50 10     <ENTER> 
Gas Name: Name your mixture using a maximum of 6 characters.
Gas Mix Number: COMPOSER™ user mixes have MATHESON gas numbers 
between 236 and 255. You can assign any number in this range to your new 
mixture. If another mixture with the same number exists, it will be overwritten, 
even if that gas is currently selected on the unit. If you enter a 0 here, the new 
mix will be assigned the next available number between 236 and 255.
Percent 1: The percentage of the first constituent gas. The percentage of each 
constituent must be between 0.01 and 99.99. Values entered beyond two 
decimal points will be rounded to the nearest 0.01%.
Gas Number 1: The MATHESON gas number of the first constituent gas.
Percent 2: The percentage of the second constituent gas. Values entered 
beyond two decimal points will be rounded to the nearest 0.01%.
Gas Number 2: The MATHESON gas number of the second constituent gas.
Additional Gases: (Optional) The above pattern of [Percent] + [Gas Number] 
may be repeated for additional constituent gases (up to a total of five).
Upon success, the unit ID (if set) is returned followed by a space. The number 
of the gas mixture is then returned, followed by the percentages and names 
of each constituent in the mix. If the gas mix is not successfully created, a "?" 
is returned, and you must start over.

Delete a Gas Mixture
To delete a gas mixture, enter: 

[Unit ID]GD [Gas Number]: The number of the COMPOSER™ user mixture you 
wish to delete from the unit

Only COMPOSER™ user mixtures can be deleted with this command.
On success, the unit ID (if set) is returned followed by a space and the number of 
the gas deleted. If the gas is not successfully deleted, a "?" is returned.
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Collecting Data:
The RS-232 output updates to the screen many times per second. Very short-term 
events can be captured simply by disconnecting (there are two telephone symbol 
icons at the top of the HyperTerminal® screen for disconnecting and connecting) 
immediately after the event in question. The scroll bar can be driven up to the event 
and all of the data associated with the event can be selected, copied, and pasted into 
Microsoft® Excel® or other spreadsheet program as described below.
For longer term data, it is useful to capture the data in a text file. With the desired 
data streaming to the screen, select “Capture Text” from the Transfer Menu. Type 
in the path and file name you wish to use. Push the start button. When the data 
collection period is complete, simply select “Capture Text” from the Transfer Menu 
and select “Stop” from the sub-menu that appears.
Data that is selected and copied, either directly from HyperTerminal® or from a text 
file can be pasted directly into Excel®. When the data is pasted it will all be in the 
selected column. Select “Text to Columns...” under the Data menu in Excel® and a 
Text to Columns Wizard (dialog box) will appear. 
Make sure that “Fixed Width” is selected under Original Data Type in the first dialog 
box and click “Next”. In the second dialog box, set the column widths as desired, 
but the default is usually acceptable. Click on “Next” again.  In the third dialog 
box, make sure the column data format is set to “General”, and click “Finish”. This 
separates the data into columns for manipulation and removes symbols such as 
the plus signs from the numbers. Once the data is in this format, it can be graphed 
or manipulated as desired.	        For extended term data capture see page 32.

Data Format:
The data stream on the screen represents the flow parameters of the main mode 
in the units shown on the display. 
For mass flow controllers, there are six columns of data representing pressure, 
temperature, volumetric flow, mass flow, set-point, and the selected gas 
The first column is absolute pressure (normally in psia), the second column is 
temperature (normally in °C), the third column is volumetric flow rate (in the 
units specified at time of order and shown on the display), the fourth column is 
mass flow (also in the units specified at time of order and shown on the display), 
the fifth column is the currently selected set-point value, the sixth column 
designates the currently selected gas. For instance, if the controller was ordered 
in units of scfm, the display on the controller would read 2.004 scfm and the last 
two columns of the output below would represent volumetric flow and mass 
flow in cfm and scfm respectively.

+014.70 +025.00 +02.004 +02.004 2.004 Air
+014.70 +025.00 +02.004 +02.004 2.004 Air
+014.70 +025.00 +02.004 +02.004 2.004 Air
+014.70 +025.00 +02.004 +02.004 2.004 Air
Pressure Temp Vol. Flow Mass Flow Set Point Gas

829-Series Mass Flow Controller Data Format
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Sending a Simple Script File to HyperTerminal®
It is sometimes desirable to capture data for an extended period of time. Standard 
streaming mode information is useful for short term events, however, when 
capturing data for an extended period of time, the amount of data and thus the 
file size can become too large very quickly. Without any special programming 
skills, the user can use HyperTerminal® and a text editing program such as 
Microsoft® Word® to capture text at user defined intervals.
1. Open your text editing program, MS Word for example.
2. Set the cap lock on so that you are typing in capital letters.
3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using MS
Word, you can tell how many lines you have by the line count at the bottom of the
screen. The number of lines will correspond to the total number of times the flow
device will be polled, and thus the total number of lines of data it will produce.
For example:	 A

A
A
A
A
A

will get a total of six lines of data from the flow meter, but you can 
enter as many as you like.

The time between each line will be set in HyperTerminal.
4. When you have as many lines as you wish, go to the File menu and select save.
In the save dialog box, enter a path and file name as desired and in the “Save as
Type” box, select the plain text (.txt) option. It is important that it be saved as a
generic text file for HyperTerminal to work with it.
5. Click Save.
6. A file conversion box will appear. In the “End Lines With” drop down box, select
CR Only. Everything else can be left as default.
7. Click O.K.
8. You have now created a “script” file to send to HyperTerminal. Close the file
and exit the text editing program.
9. Open HyperTerminal and establish communication with your flow device as
outlined in the manual.
10. Set the flow device to Polling Mode as described in the manual. Each time you
type A<Enter>, the meter should return one line of data to the screen.
11. Go to the File menu in HyperTerminal and select “Properties”.
12. Select the “Settings” tab.
13. Click on the “ASCII Setup” button.
14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will tell
the program how often to read a line from the script file you’ve created. 1000
milliseconds is one second, so if you want a line of data every 30 seconds, you
would enter 30000 into the box. If you want a line every 5 minutes, you would
enter 300000 into the box.
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15. When you have entered the value you want, click on OK and OK in the
Properties dialog box.
16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).
17. Browse and select the text “script” file you created.
18. Click Open.
19. The program will begin “executing” your script file, reading one line at a time
with the line delay you specified and the flow device will respond by sending one
line of data for each poll it receives, when it receives it.
You can also capture the data to another file as described in the manual under 
“Collecting Data”. You will be simultaneously sending it a script file and capturing 
the output to a separate file for analysis.

Operating Principle

All 829-Series Gas Flow Controllers are based on the accurate measurement of 
volumetric flow. The volumetric flow rate is determined by creating a pressure drop 
across a unique internal restriction, known as a Laminar Flow Element (LFE, and 
measuring differential pressure across it. The restriction is designed so that the gas 
molecules are forced to move in parallel paths along the entire length of the passage; 
hence laminar (streamline) flow is established for the entire range of operation of the 
device. Unlike other flow measuring devices, in laminar flow meters the relationship 
between pressure drop and flow is linear. 

STANDARD GAS DATA TABLES: Those of you who have older MATHESON 
products may notice small discrepancies between the gas property tables of 
your old and new units. MATHESON has incorporated the latest data sets from 
NIST (including their REFPROP 9 data where available) in our products’ built-in 
gas property models. Be aware that the calibrators that you may be using may 
be checking against older data sets such as the widely distributed Air Liquide 
data. This may generate apparent calibration discrepancies of up to 0.6% of 
reading on well behaved gases and as much as 3% of reading on some gases such 
as propane and butane, unless the standard was directly calibrated on the gas in 
question. 
As the older standards are phased out, this difference in readings will cease to 
be a problem. If you see a difference between the MATHESON meter and your 
in-house standard, in addition to calling MATHESON at 800-828-4313, call the 
manufacturer of your standard for clarification as to which data set they used 
in their calibration. This comparison will in all likelihood resolve the problem.
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Supported Units: This device supports many different units. You may select the desired units (see 
page 28). Note that only units appropriate to this device are available for selection.

Pressure Units
Absolute Gauge Differential Notes

PaA PaG PaD pascal
hPaA hPaG hPaD hectopascal
kPaA kPaG kPaD kilopascal
MPaA MPaG MPaD megapascal
mbarA mbarG mbarD millibar
barA barG barD bar

g/cm2A g/cm2G g/cm2D gram force per square centimeter
kg/cmA kg/cmG kg/cmD kilogram force per square centimeter

PSIA PSIG PSID pound force per square inch
PSFA PSFG PSFD pound force per square foot

mTorrA mTorrG mTorrD millitorr
torrA torrG torrD torr

mmHgA mmHgG mmHgD millimeter of mercury at 0 C
inHgA inHgG inHgD inch of mercury at 0 C

mmH2OA mmH2OG mmH2OD millimeter of water at 4 C (NIST conventional)
mmH2OA mmH2OG mmH2OD millimeter of water at 60 C
cmH2OA cmH2OG cmH2OD centimeter of water at 4 C (NIST conventional)
cmH2OA cmH2OG cmH2OD centimeter of water at 60 C
inH2OA inH2OG inH2OD inch of water at 4 C (NIST conventional)
inH2OA inH2OG inH2OD inch of water at 60 C

atm atmosphere
m asl meter above sea level (only in /ALT builds)
ft asl foot above sea level (only in /ALT builds)

V volt; no conversions are performed to or from other units
count count count setpoint count, 0 – 64000

% % % percent of full scale

Flow Units
Volumetric Standard Normal Notes

uL/m SuL/m NuL/m microliter per minute
mL/s SmL/s NmL/s milliliter per second

mL/m SmL/m NmL/m milliliter per minute
mL/h Sml/h NmL/h milliliter per hour

L/s SL/s NL/s liter per second
LPM SLPM NLPM liter per minute
L/h SL/h NL/h liter per hour

US GPM US gallon per minute
US GPH US gallon per hour

CCS SCCS NCCS cubic centimeter per second
CCM SCCM NCCM cubic centimeter per minute

cm3/h Scm3/h Ncm3/h cubic centimeter per hour
m3/m Sm3/m Nm3/m cubic meter per minute
m3/h Sm3/h Nm3/h cubic meter per hour
m3/d Sm3/d Nm3/d cubic meter per day
in3/m Sin3/m cubic inch per minute
CFM SCFM cubic foot per minute
CFH SCFH cubic foot per hour

kSCFM 1000 cubic feet per minute
count count count setpoint count, 0 – 64000

% % % percent of full scale
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True Mass Flow Units
Label Notes
mg/s milligram per second

mg/m milligram per minute
g/s gram per second

g/m gram per minute
g/h gram per hour

kg/m kilogram per minute
kg/h kilogram per hour
oz/s ounce per second

oz/m ounce per minute
lb/m pound per minute
lb/h pound per hour

These can be used for mass flow on gas devices. These can also be used for volumetric flow on liquid 
devices calibrated in one of these units (liquid density is not yet supported).

Total Mass Units
Label Notes

mg milligram
g gram

kg kilogram
oz ounce
lb pound

These can be used for totalized mass on gas devices. These can also be used for totalized 
volume on liquid devices calibrated in one of these units (liquid density is not yet supported).

Temperature Units
Label Notes

°C degree Celsius
°F degree Farenheit
K Kelvin
°R degree Rankine

Time Units
Label Notes
h:m:s Displayed value is hours:minutes:seconds

ms millisecond
s second

m minute
hour hour
day day

Valve Drive Units
Label Notes
count +/- 65536 at full drive

% Percent of full scale drive



42

TROUBLESHOOTING

Display does not come on or is weak.
Check power and ground connections. Please reference the technical specifications 
(page 45) to assure you have the proper power for your model.

Flow reading is approximately fixed either near zero or near full scale 
regardless of actual line flow.
Differential pressure sensor may be damaged. A common cause of this problem 
is instantaneous application of high-pressure gas as from a snap acting solenoid 
valve upstream of the meter. If you suspect that your pressure sensor is 
damaged please discontinue use of the controller and contact MATHESON.

Displayed mass flow, volumetric flow, pressure or temperature is flashing and 
message MOV, VOV, POV or TOV is displayed:
Our flow meters and controllers display an error message (MOV = mass 
overrange, VOV = volumetric overrange, POV = pressure overrange, TOV = 
temperature overrange) when a measured parameter exceeds the range of the 
sensors in the device. When any item flashes on the display, neither the flashing 
parameter nor the mass flow measurement is accurate. Reducing the value of 
the flashing parameter to within specified limits will return the unit to normal 
operation and accuracy. If the unit does not return to normal contact 
MATHESON.

After installation, there is no flow.
MATHESON MC controllers incorporate normally closed valves and require a set-
point to operate. Check that your set-point signal is present and supplied to the 
correct pin and that the correct set-point source is selected under the SETPT 
SOURCE list in the control set up display. Also check that the unit is properly 
grounded. 

The flow lags below the set-point.
Be sure there is enough pressure available to make the desired flow rate. If 
either the set-point signal line and/or the output signal line is relatively long, it 
may be necessary to provide heavier wires (especially ground wiring) to negate 
voltage drops due to line wire length. An inappropriate PID tuning can also 
cause this symptom if the D term is too large relative to the P term. See pages 
16 and 17 for more information on PID tuning.

Controller is slow to react to a set-point change or imparts an oscillation to the flow. 
An inappropriate PID tuning can cause these symptoms. Use at conditions 
considerably different than those at which the device was originally set up 
can necessitate a re-tuning of the PID loop. See pages 16 and 17 for more 
information on PID tuning.

The output signal is lower than the reading at the display.
This can occur if the output signal is measured some distance from the meter, as 
voltage drops in the wires increase with distance. Using heavier gauge wires, 
especially in the ground wire, can reduce this effect.
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Meter does not agree with another meter I have in line.
Volumetric meters are affected by pressure drops. Volumetric flow meters 
should not be compared to mass flow meters. Mass flow meters can be 
compared against one another provided there are no leaks between the two 
meters and they are set to the same standard temperature and pressure. Both 
meters must also be calibrated (or set) for the gas being measured. M-Series 
mass flow meters are normally set to Standard Temperature and Pressure 
conditions of 25 ° C and 14.696 psia. Note: it is possible to special order meters 
with a customer specified set of standard conditions. The calibration sheet 
provided with each meter lists its standard conditions.
When performing this comparison it is best to use the smallest transition 
possible between the two devices. Using small transitions will minimize lag and 
dead volume.

RS-232 Serial Communications is not responding.
Check that your meter is powered and connected properly. Be sure that the 
port on the computer to which the meter is connected is active. Confirm that 
the port settings are correct per the RS-232 instructions in this manual (Check 
the RS-232 communications select screen for current meter readings). Close 
Hyperterminal® and reopen it. Reboot your PC. See pages 9 and 26 for more 
information on RS-232 signals and communications.

Slower response than specified.
829-Series Controllers feature a programmable Geometric Running Average
(GRA). Depending on the full scale range of the meter, it may have the GRA
set to enhance the stability/readability of the display, which would result in
slower perceived response time. Please see “Pressure Averaging” and “Flow
Averaging” on page 22.

Jumps to zero at low flow.
829-Series Controllers feature a programmable zero deadband. The factory
setting is usually 0.5% of full scale. This can be adjusted between NONE and
6.3% of full scale. See page 22.

Discrepancies between old and new units.
Please see “Standard Gas Data Tables” explanation on page 33.
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Maintenance and Recalibration

General: 829-Series Flow Controllers require minimal maintenance. They 
have no moving parts. The single most important thing that affects the life 
and accuracy of these devices is the quality of the gas being measured. The 
controller is designed to measure CLEAN, DRY, NON-CORROSIVE gases. 

Moisture, oil and other contaminants can affect the laminar flow elements. 
We recommend the use of in-line sintered filters to prevent large particulates 
from entering the measurement head of the instrument. Suggested maximum 
particulate sizes are as follows:

15 microns for units with FS flow ranges between 0-100 sccm and 0-1 slpm.
50 microns for units with FS flow ranges of 0-1 slpm or more.

Recalibration: The recommended period for recalibration is once every year. A 
label located on the back of the controller lists the most recent calibration date. 
The controller should be returned to the factory for recalibration within one 
year from the listed date. Before calling to schedule a recalibration, please note 
the serial number on the back of the instrument. The Serial Number, Model 
Number, and Date of Manufacture are also available on the Model Info display 
(page 29.

Cleaning: 829-Series Flow Controllers require no periodic cleaning. If necessary, 
the outside of the controller can be cleaned with a soft dry cloth. Avoid excess 
moisture or solvents.

For repair, recalibration or recycling of this product contact:

MATHESON
166 Keystone Drive

Montgomeryville, PA 18936
Ph: 800-828-4313

Web: www.mathesongas.com
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Technical Data for MATHESON 829 Mass Flow Controllers
0 to 100 sccm Full Scale through 0 to 10 slpm Full Scale

Standard Operating Specifications (Contact MATHESON for available options)
Performance 829 Mass Flow Controller

Accuracy at calibration 
conditions after tare ± (0.8% of Reading + 0.2% of Full Scale)

High Accuracy at calibration 
conditions after tare ± (0.4% of Reading + 0.2% of Full Scale)

Repeatability ± 0.2% Full Scale
Zero Shift and Span Shift 0.02% Full Scale / ºCelsius / Atm

Operating Range / Turndown 
Ratio 0.5% to 100% Full Scale / 200:1 Turndown

Maximum Controllable Flow Rate 102.4% Full Scale
Typical Response Time 100 ms (Adjustable) 

Warm-up Time < 1 Second

Communications / Power 829  Mass Flow Controller
Monochrome LCD Display with 

integrated touchpad Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature

Digital Input/Output Signal1 RS-232 Serial 

Analog Input/Output Signal2 0-5 Vdc / 4-20 mA

Electrical Connection Options RJ45
Supply Voltage 12 to 30 Vdc  (15-30 Vdc for 4-20 mA outputs)
Supply Current 0.250 Amp 

1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature
2. The Analog Output Signal communicate your choice of Mass Flow, Volumetric Flow, Pressure or Temperature

Operating Conditions 829 Mass Flow Controller
Mass Reference Conditions (STP) 25ºC & 14.696 psia (standard — others available on request)

Operating Temperature −10 to +50 ºCelsius
Humidity Range (Non–Condensing) 0 to 100%
Max. Internal Pressure (Static) 145 psig

Proof Pressure 175 psig
Mounting Attitude Sensitivity None 

Valve Type Normally Closed
Ingress Protection IP40

Wetted Materials
303 & 302 Stainless Steel, Viton®, Heat Cured Silicone Rubber, Glass Reinforced 
Polyphenylene Sulfide, Heat Cured Epoxy, Aluminum, Gold, Brass, 430FR Stainless 
Steel, Silicon, Glass.
If your application demands a different material, please contact MATHESON.

Range Specific Specifications
Full Scale Flow Mass 

Controller
Pressure Drop at FS Flow  

(psid) venting to atmosphere
Mechanical 
Dimensions Process Connections1

100 sccm to 500 sccm 1.0

4.1”H x 3.6”W x 1.1”D 1/8” NPT Female
1 slpm 1.5
2 slpm 3.0
5 slpm 2.0
10 slpm 5.5

1. Compatible with, Swagelok® tube, Parker®, face seal, push connect and compression adapter fittings. VCR and SAE 
connections upon request.
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




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RJ45 Connector Pin-Outs

1. RS-232 Receive
2. Ground
3. Analog Output
4. RS-232 Transmit
5. Power Supply
6. Power Supply
7. Analog Input
8. Ground

1 2 3 4 5 6 7 8

RJ45 Device

8 7 6 5 4 3 2 1

RJ45 Cable
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